
CHAP T E R 3

Getting Started

3.1 Start Eclipse

Start in your home directory. There are three ways to start Eclipse, indeed to start any

program under Linux running a graphical desktop environment:

� In a shell window, execute <path_to_eclipse>eclipse.

� In a file manager window, double-click the eclipse executable.

� Click on a custom launch button in the toolbar.

Eclipse always begins by asking you to select a workspace (Figure 3.1). The default

workspace is the directory workspace/ under your home directory. If the directory doesn’t

Figure 3.1: Workspace dialog.
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exist, Eclipse will create it. If this is likely to be the only workspace you use, check the Use

this as the default and do not ask again box to bypass this dialog.

If the workspace did not exist, Eclipse brings up a Welcome screen (Figure 3.2).

This offers the opportunity to learn more about Eclipse before jumping right into it.

Icons include:

Overview of Eclipse features

What’s new in this release

Samples

Tutorials

Go to the Workbench

The next time you start Eclipse in the same workspace the Welcome screen won’t be

displayed but you can always get back to it by clicking Help –> Welcome. For now

click Go to the workbench, but feel free to come back to the samples and tutorials at

any time.

3.2 Basic Concepts

At its core, Eclipse is really just a collection of tools for managing and manipulating

files. The magic of course is in how these tools and other software components are

structured and integrated. The user’s view of Eclipse is a desktop known as a

Workbench. Figure 3.3 is the empty workbench window that comes up before we’ve

created any projects or files.

Across the top of the workbench window is a menu bar with familiar entries such

as File, Edit, Search, Window, and Help, as well as some menus specific to

Eclipse like Refactor, Navigate, Run, and Project. Below that is a tool bar whose

icons may change depending on which perspective is visible and which view or

www.newnespress.com

32 Chapter 3



editor has the focus. The visible perspective is changed by clicking the button at

the far right of the tool bar. Eclipse CDT offers three default perspectives: C/C++

that is currently visible, Debug, and Team Synchronizing. Two other perspectives

are available by selecting the Other. . . button, CVS Repository Exploring, and

Resource.

It is helpful to have a project open in order to discuss Eclipse basic concepts. Select

File –> New –> C Project. In the Project name: field enter “hello”. Under Project

types: click the right arrow next to Executable and select Hello World ANSI C

Project (see Figure 3.4). Click Next to bring up the Basic Settings dialog. Enter

your name as the Author and change the Copyright notice and Hello world greeting,

if you choose. Click Finish. The Project Explorer window on the left side of the

workbench now shows some information about the hello project.

Figure 3.2: Welcome screen.
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3.3 Perspectives, Editors, and Views

The Workbench window contains one or more Perspectives that are, in turn,

collections of Views and Editors. A Perspective defines an initial set of views, and the

layout of those views, to accomplish some specific task on a particular set of resources,

or files. The workbench is currently displaying the C/C++ perspective typical of Eclipse

CDT.

A workbench may have several perspectives open, but only one perspective is visible in

a window. To make additional perspectives visible, open additional windows using the

Window –> New Window command.

Figure 3.3: Empty workbench.
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The large space in the center of the workbench is the Editor. As you might expect, the

editor allows you to open, modify, and save files. The editor window is the central

feature of virtually all Eclipse perspectives. Different editors can be associated with

different file types. Opening a file then starts up the corresponding editor, which may

also change the contents of the menu and tool bars. The editor associated with C source

files has a number of useful features that we’ll look at shortly.

Figure 3.4: New project dialog.
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Multiple files can be open in the editor and are identified by tabs across the top

of the editor window. An asterisk, “*”, indicates the file has unsaved changes.

Clicking the “X” icon to the right of the file name in the currently visible tab closes

the file.

Views support editors and provide alternative presentations of the information in a

project as well as ways to navigate that information. Views most often appear in tabbed

stacks to the right and left of the editor window and sometimes beneath it. Icons on

the right end of the tab bar allow the currently visible view in that stack to be minimized

or maximized. Views also have their own menus represented by the down arrow icon

at the far right of the view tab. Frequently used menu items may be represented by

other icons in the tab.

Figure 3.5 is an example of the view menu for the Project Explorer view. The menu

items are primarily concerned with how the view is displayed.

A view can be moved around anywhere in the Workbench by dragging its title bar.

As you move the view around, the mouse pointer changes to one of the drop cursors

shown in Figure 3.6. This indicates where the view will be docked if you release

the mouse. Try it with the Outline view on the right.

The default C/C++ perspective displays the Project Explorer view on the left and an

Outline view on the right. The Project Explorer provides a hierarchical view of the

Figure 3.5: Project Explorer view menu.
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resources contained in a project. It allows for adding or importing new files or

directories, deleting or exporting files, and opening files for editing.

The Outline view displays an outline of the structural elements of the file currently visible

in the editor window. Since we don’t currently have a file open in the editor, the

Outline view is empty. Click the arrow to the left of the project name in the Project

Explorer to expand the project. Then expand the src entry to reveal the file hello.c.

Either double-click on hello.c or right-click and select Open. The source file shows

up in the editor and there’s now something in the Outline view on the right (Figure 3.7).

Note first of all that the editor, like any good programming language editor, employs

syntax coloring. Click just to the right of the opening brace in main and note that

the closing brace is highlighted. Try the same thing with the left parenthesis of the puts

statement.

With the cursor located anywhere in the main function, the vertical bar on the left,

known as the marker bar, shows the extent of main. The same thing happens if you

click on main in the Outline view.

Roll your mouse over puts. A help window pops up showing the function declaration

from the header file along with any comments associated with that declaration.

Dock above: The view is docked above the view underneath the cursor.

Where the view will be moved to
Drop
cursor

Dock below: The view is docked below the view underneath the cursor.

Dock to the right: The view is docked to the right of the view underneath the cursor.

Dock to the left: The view is docked to the left of the view underneath the cursor.

Stack: The view is docked as a Tab in the same pane as the view underneath the cursor.

Detached: The view is detached from the Workbench window and is shown in its own separate
window

Restricted: You cannot dock the view in this area.

Figure 3.6: Drop cursor icons.
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It’s also worth noting that as soon as you created the hello project, Eclipse built it using

the default gcc compiler. The results of the build are shown in the Console view

below the editor. This brings us to a discussion of all four of the views that normally

appear below the editor.

3.3.1 Problems View

If any errors or warnings are encountered in the course of building a project, they will

be logged in the Problems view. Currently that view is empty because the project built

successfully. It’s easy enough to introduce an error, for example, by deleting the

semicolon at the end of the puts statement.

Figure 3.7: hello.c in editor window.
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Make that change and save the file. Note that by default, Eclipse does not

automatically save any changed files before it builds a project. There is a preference

option to save automatically before a build.1 We’ll look at preferences later in this

chapter.

There are several ways to build the project. For now select Project –> Build All.

The Problems view now shows a syntax error and tells us where it is. The error line is

also identified in the editor with an icon in the marker bar. By default, problems are

grouped by severity with different icons in the first column representing warnings

and errors. If there are several items in the Problems view, clicking on an item moves

the editor to the corresponding line, opening the file if necessary.

The Problems view can be filtered to show only warnings and/or errors for a particular

resource or group of resources (Figure 3.8). Filters are accessed from the Problems

view menu –> Configure filters. . . You can create multiple filters and enable and

disable them as needed. Filters are “additive” so that any problem that satisfies at least

one enabled filter will be shown.

Problems can also be sorted along several dimensions by selecting Sort By from the

Problems view menu.

3.3.2 Tasks View

The Tasks view lets you create tasks related to the project and link those tasks to

specific resources. There are several ways to add a task to the list. Right-click in

the Tasks view and select Add Task to bring up the dialog in Figure 3.9. Here you

can enter a description of the task and its priority. You can even check the task as

completed although it’s a little hard to understand why you would be adding a task

that’s already completed.

There are text boxes for entering an Element, Folder, and Location, but oddly enough

you can’t enter anything there. So tasks created by this method can’t be linked to a

resource. To create a task linked to a resource, hello.c for example, right-click in the

marker bar on the left side of the editor window and select Add Task. Try it on the

comment line that says “Copyright.” The same dialog box comes up but now it’s

1 Personally, I think that should be the default.
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labeled Properties instead of Add Task, and the Element, Folder, and Location fields

are filled in.

Change the description to “update copyright” and click OK. A task icon appears in

the marker bar at line 6. Like Problems, Tasks can be filtered to show only a relevant

subset and can be sorted along several dimensions. Your Task view should look

something like Figure 3.10.

Figure 3.8: Problems filter.
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3.3.3 Console View

The primary role of the Console view is to display program output, and output from

the build tools. The Console view is connected to stdin, stdout, and stderr.

Although several consoles may be open at any given time, only one is visible in the view.

An icon on the tab bar lets you select the visible console.

Figure 3.11 shows two different console views (a and b). When a program is running in

the console, a red rectangle icon appears that can terminate the program. Other icons

remove terminated console views, clear the console, open a new console, and lock

scrolling.

Figure 3.9: Add Task dialog.

Figure 3.10: Task view.
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The Console view only represents programs that are running on the host. Programs

running on an external target will display their output in some other fashion, such as

a terminal emulator window. In Chapter 6, “Device Software Development Platform,”

we’ll look at an Eclipse project that makes remote programs visible in the Console

view.

3.3.4 Properties View

Every object and/or resource in Eclipse has certain “properties,” the natures of which

depend on the type of object. The Properties view shows the properties of any object

selected in one of the other views. With the Properties view visible, click on the project

name “hello” in the Project Explorer view to bring up something like Figure 3.12.

Click on “hello.c” in the Project Explorer view to see a slightly different set of

properties. The Properties view is read-only—you can’t change anything here—and to

be honest, it doesn’t tell you a whole lot. A more extensive, editable view of properties

is available from an object’s context menu described later in this chapter.

Figure 3.11: Console views (a and b).
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Thus far we’ve explored several of the more common views available in Eclipse. Later

on we’ll encounter other views more specific to the C development environment.

3.4 Menus

Like any good windowing program, Eclipse has a set of menus arrayed across the top of

the main display window. Most of the items in these menus are fairly familiar, but

a few deserve some additional description.

3.4.1 File Menu

This is a fairly standard file menu. Some additional items worth mentioning are:

� Convert Line Delimiters To: Changes how text lines are terminated for the

selected file. Each of the three major operating systems that Eclipse supports

has a different convention for how text lines are terminated:

1. Unix (default): Line feed (0xa)

2. Windows: Carriage return and line feed (0xd, 0xa)

3. Mac OS/9: Carriage return (0xd)

Figure 3.12: Properties view.
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The changes are immediate and persist until you change the delimiter again. It’s

not necessary to explicitly save the file.

� Import: Allows resources to be imported into the selected project.

� Export: Allows resources to be exported out of a project to some other

location.

� Switch Workspace: Allows you to change to a different workspace. This

restarts the workbench.

3.4.2 Edit Menu

The Edit menu also has many of the familiar options. Some Eclipse- and CDT-specific

features include:

� Incremental Find Next/Previous: Search for expressions in the active editor.

As you type the search expression, Eclipse incrementally jumps to the

next/previous exact match.

� Add Bookmark: Adds a bookmark in the active file on the line where the

cursor is displayed.

� Add Task: Adds a task in the active file on the line where the cursor is

displayed.

� Word Completion (Alt + /): Attempts to complete the word currently being

entered in the active editor.

� Quick fix: Supposedly offers suggestions on correcting certain errors when the

cursor is on a line that has an error. Unfortunately, the only thing I’ve seen so

far is “No suggestions available.”

� Content Assist: Opens a dialog at the current cursor location to offer assistance

in the form of proposals and templates. The templates can be configured

through the Window menu at Window –> Preferences –> C/C++ –> C/C++

Editor –> Content Assist.

� Parameter Hints: Displays the parameter portion of a function prototype.

� Format: Reformats a source file to match the currently selected coding style.
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3.4.3 Refactor Menu

There’s only one item in the Refactor menu: Rename. This is a way to rename a

selected object and have the change propagated through the entire project.

3.4.4 Navigate Menu

As the name implies, this menu helps you navigate through a large project in a number

of different ways. We’ll look at many of these menu items in more detail in the

next chapter, where we get into C programming:

� Open Type Hierarchy: Displays the Type Hierarchy view for the selected

object, provided the object resolves to a defined type.

� Open Call Hierarchy: Displays the Call Hierarchy view for the selected

function. The Call Hierarchy can show which functions call this function, and

which functions this function calls.

� Open Declaration: Opens the declaration of the selected object: a function,

variable, class, type, etc.

� Open Resource: Displays a dialog allowing you to select any resource in the

workspace to open in an editor.

� Last Edit Location: Moves the cursor to the line that contains the most

recent edit.

� Go to Line: Displays a dialog to specify a line number to which to move the

cursor.

3.4.5 Search Menu

The Search menu offers three different ways to search for text, represented by four

menu items. Figure 3.13 shows the C/C++ search dialog that allows you to search

for text in specific language elements. The scope of the search can be the entire

workspace or the set of resources selected in the Project Explorer view. The results

of the search appear in the Search view.
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Figure 3.14 shows the File search dialog. Here you can search for a text string, a regular

expression, and/or a file name pattern. Again, the search can encompass the entire

workspace or only selected resources, and the results of the search appear in the

Search view.

Finally, with the cursor set in any word, you can select Search –> Text and

immediately see the Search view with a list of the files containing the selected text.

3.4.6 Project Menu

The Project menu is concerned, perhaps not surprisingly, with managing projects, which

is in fact the primary organizing principle of Eclipse. The menu includes items for

opening and closing projects, building projects, and making specific targets.

Figure 3.13: C/C++ Search dialog.
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Select the hello project in the Project Explorer view and click the Project menu. Menu

items include:

� Close Project: Closes the selected project(s). Any project files open in editors

are closed and the hierarchy in the Project Explorer view is collapsed.

� Open Project: A project that was previously closed can be opened. Note that

the Project Explorer view must have the focus for Open and Close to be active.

� Build All: Builds all projects in the workspace. Currently there’s only one, the

“hello” project. Clicking Build All now will probably result in the message

“Nothing to be done for ‘all’” since the project has already been built. This is a

full build, that is, all files are built.

� Build Project: Builds the project currently selected in the Project Explorer

view. This is a full build.

Figure 3.14: File Search dialog.
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� Build Configurations: Allows you to set the active configuration, either Debug

or Release. Build All and Build Project build the active configuration.

� Clean: Cleans either all projects or selected projects, as determined by a dialog.

The selected projects are then rebuilt.

� Build Working Set: If you have created one or more working sets you can

have Eclipse just build the selected working set. We’ll look at working sets

in the next chapter.

� Build Automatically: If this item is checked then the project is automatically

rebuilt any time a project file is saved. This is probably not a very good idea

for very large projects.

� Make Target: Opens a submenu that allows you to create and then build

additional make targets. We’ll look at this is in the next chapter.

� Properties: Opens a rather extensive properties dialog, an example of which

is shown in Figure 3.15. This particular tab sets options for the gcc compiler

and linker. These settings are for the selected configuration.

3.4.7 Run Menu

Having built a project, the next thing we probably want to do is run or debug it.

Eclipse runs projects from a launch configuration that specifies the program to

run, its arguments and environment, and how the program connects to Eclipse

(i.e., is it a local process or is it running remotely on a target board of some

sort?). A launch configuration also specifies the debugger and how it connects

to Eclipse.

Before we run or debug a project, we must first create a launch configuration.

Click on Run –> Run Configurations . . . Click the New button, the one farthest

to the left in the left-hand panel, to create a new configuration under “C/C++

Local Application.” This brings up the dialog shown in Figure 3.16.

The configuration name has been automatically set to match the project name.

You need to select an application to run by clicking Search Project . . . and then

selecting /hello/Release/hello. Click the other tabs just to see what’s there. The

hello program takes no arguments and has no environment variables. We’ll look at the

Debugger tab in the next chapter.
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Now click Apply and then click Run. The program output appears in the Console view.

With at least one launch configuration established, the other Run menu actions

become meaningful:

� Run: Rerun the most recent launch in Run mode.

� Run History: Presents a submenu of configurations launched in Run mode.

Currently there’s only one.

Figure 3.15: Project properties dialog.
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� Run As: Presents a submenu with one item: “Local C/C++ Application.”

Clicking that brings up a dialog where you can select either the release or debug

binary to run.

� Debug: Rerun the most recent launch in Debug mode.

� Debug History: Presents a submenu of configurations launched in Run mode.

Currently there’s only one.

� Debug As: Presents a submenu with one item: “Local C/C++ Application.” Clicking

that brings up a dialog where you can select either the release or debug binary to run.

Figure 3.16: Launch configuration dialog.
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� Debug Configurations. . .: Opens the launch configuration dialog for

debug mode configurations. The hello configuration we created for run

mode is selected and can be used as-is. We’ll explore debugging in the

next chapter.

The Run menu also includes a number of execution control actions that are used for

debugging.

3.4.8 Window Menu

This menu offers a number of options for selecting views and perspectives and moving

around the workbench. Actions include:

� New Window: Opens a new workbench instance. This allows you to have

two or more perspectives visible at once.

� New Editor: Opens an empty editor window.

� Open Perspective: Allows you to select another perspective. The choices

offered depend on where you are. In any case, there’s always an Other. . .

case that lists all of the perspectives available.

� Show View: Brings up a list of views to make visible. Depending on

where you are, the views you are most likely to be interested in are

listed first. Again, there’s an Other . . . selection to select any possible

view.

� Customize Perspective: Each perspective includes a predefined set of

actions accessible from menus and the workbench toolbar. This command

brings up a dialog that lets you customize the actions in the current

perspective.

� Save Perspective As: Saves the current perspective, thus giving you the

opportunity to create custom perspectives, which may be opened with

Window –> Open Perspective –> Other.

� Reset Perspective: Returns the current perspective to its original layout.

� Close Perspective: Closes the current perspective. Basically, this just makes

another open perspective visible.
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� Close All Perspectives: Closes all open perspectives. This leaves the

workbench essentially blank with just the Open Perspective icon visible.

All open editors are closed.

� Navigation: Brings up an extensive submenu that provides another way to

move among views, perspectives, and editors.

� Preferences . . .: Leads you to the configuration dialog for Eclipse. There are

many preference options, which are the subject of the next section.

3.4.9 Help Menu

Eclipse comes with extensive help documentation that can be accessed in different ways:

� Welcome: Displays the welcome screen with access to tutorials and examples.

� Help Contents: Opens a new help window. A navigation panel on the left

lets you browse through two user guides: the Workbench User Guide and the

C/C++ Development User Guide. There’s also a search window.

� Search: This is one of several help actions that pops up a Help view in the

current perspective. See Figure 3.17.

� Dynamic Help: Brings up the Help view as another way to browse the help files.

� Key Assist. . . : Displays a pop-up window with all of the shortcut keys.

� Tips and Tricks . . . : Displays some helpful ideas for improving productivity

in the separate help window.

� Report Bug or Enhancement. . .: Provides a convenient mechanism for filing bug

reports.

� Cheat Sheets . . . : These are short tutorials that display in the Cheat Sheets view.

� Software Updates: Finds and installs updates to Eclipse software. You have

a choice between updating only currently installed features, and searching for

new features to install.

� About Eclipse Platform: The usual “about” type of information. Buttons

provide additional information about features, plug-ins, and configuration

details.
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3.4.10 Context Menu

Again, like any good windowing program, Eclipse offers several different ways to

invoke its functionality. In addition to the menus described above, many Eclipse actions

are available from the toolbar just below the menu bar. The actions available in the

toolbar may change depending on which perspective is visible and which view has

the focus.

In addition, just about every object has a Context menu, accessed by right-clicking on

the object. The Context menu includes a collection of actions derived from the other

menus that are commonly performed on the selected object.

For example, right-click on the project name, “hello,” in the Project Explorer to

bring up the menu shown in Figure 3.18. This includes actions from the File, Project,

Figure 3.17: Workbench with Help view visible.
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and Run menus that are useful to perform at the project level. Right-clicking on hello.c

brings up a similar, yet slightly different menu. For a completely different Context

menu, right-click on one of the entries in the Outline view.

Figure 3.18: Project-level Context menu.
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Browse around different views and different objects to get a feel for the range of the

Context menus.

3.5 Configuring Eclipse

Perhaps not surprisingly, Eclipse offers an extensive array of configuration options that

let you tailor its appearance and operation to your particular tastes or to company

development standards. The Preferences dialog shown in Figure 3.19 is activated with

Window –> Preferences.

Figure 3.19: Preferences dialog.
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As shown here, preferences are arranged into six major categories. At this point, it’s

not worth going through an exhaustive explanation of all the preference options.

Many of them are somewhat obscure, in any case. There is an extensive section in both

the Workbench User Guide and the C/C++ Development User Guide that describes

all of the preference options in detail.

Briefly, the six major categories are:

� General. Pretty much what it says. There are options here for managing the

appearance of Eclipse, configuring editors and shortcut keys, startup and

shutdown operations, and other features.

� C/C++. This category manages a large number of configuration options for

CDT, including appearance, editor behavior, environment variables, debug

behavior, and more. There are a few options in this category that are worth a

closer look in this chapter (see below) and others that we’ll take a closer look at

in the next chapter.

� Help. Specifies how help information is displayed and offers a way to include

help content from a remote location.

� Install/Update. Manages the Eclipse software update and installation process.

Updates can be automatically downloaded and installed.

� Run/Debug. Manages the process of running and debugging code under

Eclipse, including things like console appearance, breakpoint behavior, and

what happens when a program is launched.

� Team. Offers preferences for using CVS and team synchronization.

Note the circle icon with the question mark in the lower left corner. Clicking this

icon brings up a context-sensitive help screen to the right of the dialog. This is, in fact,

a common feature of virtually every Eclipse dialog and is a useful way to get more

detailed information about the dialog options.

At this point it would be useful to browse around the preferences menus to get

a better feel for what’s there. Earlier, we saw that by default, Eclipse does not

save changed files before building. The option to change that behavior is in

General –> Workspace. It’s called Save automatically before build.
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3.5.1 C/C++ Preferences

Code Style

The CDT text editor incorporates “smart typing” features, that include things like auto-

indentation and formatting, that are controlled by the Code Style preference shown

in Figure 3.20. You can select from among four built-in code styles that include:

� K&R

� BSD/Allman

Figure 3.20: Code Style preference.
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� GNU

� Whitesmiths

The primary difference among the four seems to be the location and indentation of

opening and closing braces. The default is K&R, where the opening brace is on the

same line as the expression or key word that introduces the block. This seems to be the

preferred style among Linux programmers.

For what it’s worth, my personal preference is BSD/Allman, where the opening brace is

on the next line and indented to line up with the introductory expression. There are

options to edit the built-in styles, import a style, and to create a completely new one.

Among the features you can edit in the built-in styles are Tab policy and Tab size. Tab

policy specifies whether tabs are represented in the file by tab characters, 0x9, or spaces.

Editor Preferences

General editor preferences include the ability to change various colors. I find the default

color for highlighting matching braces to be a bit “subtle.” To change it, select

Matching brackets highlight under Appearance color options: and then click on the

Color: button.

A few of the more interesting editor preference subcategories are described here.

Content Assist With Content Assist, the C/C++ editor can offer suggestions about key

words and phrases commonly used in C. Type part of a keyword followed by

Ctrl+Space to bring up a list of suggestions. When the list has been reduced to one

item, the editor can automatically insert that item into your code.

The related auto-completion feature can use “.”, “->”, and “::” as triggers to invoke

auto-completion on structures and class definitions.

Content Assist is based on templates that can be specified under Template preferences

(see below).

Folding Folding hides the detailed contents of selected regions in a source file. This

can be a useful strategy for browsing through large files. Figure 3.21 is an example of a

file with functions and macros folded. Click on the “+” icon next to the name to see the

contents of a specific function or macro.
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Folding preferences let you select if folding is enabled when a new editor is opened, and

which sections of code will be folded.

Syntax Coloring There are a large number of semantic elements to which specific

coloring and font styles can be assigned. Many of these are not enabled by default and

among those that are enabled many share the same coloring. Here’s your chance to “go

wild,” if you’re so inclined, and create some exciting color schemes.

Templates Templates are the basis for Content Assist. There’s a default set of

templates representing common C/C++ code snippets. You can add your own templates

with New, and Edit existing templates.

Typing Typing preferences are another way in which the editor provides

assistance. You can tell the editor to automatically close quoted strings, parentheses,

brackets, and braces. When you type an opening parenthesis or bracket, the editor

Figure 3.21: Folded source file.
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automatically inserts the matching close and positions the cursor between them.

Type what should be enclosed, then hit Enter to position the cursor just beyond the

matching close.

Summary

This chapter has been a quick tour of basic Eclipse concepts and operation with an

emphasis on the C/C++ Development Tools (CDT) environment. We began by

examining the relationship among Perspectives, Views, and Editors. A Perspective is a

collection of Views and Editors organized to accomplish a specific function. Editors

allow files to be opened, modified, and saved. Views support Editors by providing

additional information and functionality. The selection and arrangement of Views in a

Perspective can be changed at will.

The basic functionality of Eclipse, like all windowing programs, is embodied in a set

of menus. We looked in detail at many menu, or action, items that are specific to

Eclipse. Many of these action items also appear in the tool bar and in Context menus.

Items in the tool bar may change or become active or inactive depending on which

view has the focus.

Finally, we looked at some of the many configuration and customization options

available in Eclipse with particular attention to some of the interesting features of the

CDT editor.

The next chapter goes into more detail about the CDT environment and the nature of

projects.
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